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Documentation Guide
Linux is an OS that maintains two different environments. Both have full control over the system unlike the 
windows DOS and GUI environment. As such many changes are easier to make via the terminal or command line 
environment.

For this document any command shown as below is a terminal command and should by entered into a terminal 
exactly as shown:

echo This is a terminal command.

Some changes are easier to make via the GUI and are shown in a 'path' format. This takes the form of a heading 
and arrows to point to the next heading to click until the path is found. For example:

System → Administration → Printing

This command would take you through the menu to the printing control panel.

This guide is broken into several parts:

Part 1: Installing Ubuntu
This part explains the process of installing Ubuntu from the CD and preparing it to be connected to the Griffith 
University network.

Part 2: Configuring Network Login and Home Directories.
This part explains the process of setting up Ubuntu to use LDAP authentication to log into the Linux labs. It also 
configures the /home folder to point to the student home directories on Chimera.

Part 3: General Applications
This part explains how to install applications that are considered basic and required for normal use.

Part 4: Customising Gnome
This part goes through the process of making the Image look like a GU image. It covers the customisation of the 
login theme and the desktop theme, editing defaults for the interface, and removing unwanted elements, as well 
as editing the menus to remove links to games.

Part 5: Clean Up
This part goes through the process of cleaning up the system and removing temporary files from the system to 
prepare for creating the master image.

Part 6: Application Installation
This part details the process for installing applications to support teaching in ICT and MEE environments. 

Part 7: Deployment
This part details how to prepare individual lab images for deployment
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 1 Installing Ubuntu
Base: Intrepid Ibex, Ubuntu 8.10

Partition the HDD 
 - Use a 120gB HDD as a base

– Windows in the dual boot uses between 50gB and 80gB

 1.1 Installing off the CD/DVD
Boot off the Intrepid Ibex, Ubuntu 8.10 CD
 - Choose Start and Install Ubuntu from the boot menu

Once the desktop appears, double click on the desktop shortcut to Install

Follow the prompts as they appear, and enter the following:

Where are you: Brisbane  
Keyboard layout: US english/US English

 1.1.1 Prepare disk space 
The prompts will ask you how you want to partition the disk? You want to do this manually so we can specify our 
own partitions.

You'll create the partitions below. For each one, select Device “free space” and click New Partition

Partition Type Mb Location Use as Mount point
   Root logical 15360 beginning ext3 /
   Tmp     logical 5120 beginning ext3 /tmp
   Swap logical 5120 beginning swap  <n/a>
   Extra   logical 15360 beginning ext3 /extra

/ is the root partition where linux will be installed
<na> is the swap partition that acts as a page file
/tmp is a temp file for the mounting of student homes
/extra is the install location for the larger packages (Comsol and Matlab specifically) and can be excluded from the 
ICT Image.

Click Forward     

Click  Continue  when prompted with   “Do you want to return to the partitioning menu?”  No mount point is 
assigned for the ext3 file system in partition 
#1 of SCSI1 (0,0,0) (sda) .....

Migrate Documents and Settings  -    click Forward, you do not have any to migrate

 1.1.2 Who are you?
   Name:  Administrator
   login name:  administrator
   password: <Specify administrator password>
   name of computer: DualBoot-Master
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Ready To install -  click Install
Reboot when the install is complete, removing the cd.

 1.2 Installing Updates
Comment out original update locations and add our local update settings.  RCS supplies a local update mirror for 
Ubuntu based off AARNET. If you have any problems contact RCS.

Make a backup of the original file and then edit it to contain the information for the local mirror.

sudo cp /etc/apt/sources.list /etc/apt/sources.list.orig
gksudo gedit /etc/apt/sources.list 

contents of sources.list should be :

### CANONICAL COMMERCIAL REPOSITORY 
#deb http://mirror.griffith.edu.au/pub/ubuntu-commercial/ intrepid-commercial main 

### GRIFFITH MIRROR
deb http://mirror.griffith.edu.au/pub/ubuntu/archive intrepid main universe 
multiverse restricted 
deb http://mirror.griffith.edu.au/pub/ubuntu/archive intrepid-updates main universe 
multiverse restricted 
deb http://mirror.griffith.edu.au/pub/ubuntu-partner intrepid partner

Install all existing Ubuntu updates via System → Administrator → Update Manager. Or this can be done via 
terminal by running:

sudo apt-get update
sudo apt-get upgrade

 1.3 Setup Time
We want to maintain a consistant time across all lab computers. To do so we use NTP (Network Time Protocol).
Unfortunately compared to 8.04 this is a little more complicated due to NTP settings being removed from the Date 
and Time panel.

sudo apt-get install ntp
sudo nano /etc/ntp.conf

Comment out the existing entries (using #) and add:
server 132.234.1.1

 1.4 Amend Accounts
This step should be done from the live CD to minimise issues with files locked open by your active session. To do 
this reboot the computer an boot off the Ubuntu CD and click try before you install. This step is taken in 
preparation for setting up the networked home folders for students. We move the local administrator profile 
outside the normal /home directory and change the passwd file to show the new location. The normal homes 
directory will be pointed at a server later.

Mount the linux root partition (/)
sudo mkdir /media/root 
sudo mount /dev/sda5 /media/root 

Modify Groups file
gksudo gedit /media/root/etc/group

Add Student to groups by adding the following line
student:x:10000:
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Remove the group administrator, by removing the following line
administrator:x:1000: 

Move local administrators home to /usr/home by first modifying the accounts file
gksudo gedit /media/root/etc/passwd

set administrator home to /usr/home/administrator
set administrator group to 100   #user group
it should look like this....
administrator:x:1000:100:administrator,,,:/usr/home/administrator:/bin/bash 
 
Now move the administrator's home directory

sudo mkdir /media/root/usr/home
(Creates local user home at /usr/home)

sudo rsync -aS /media/root/home/administrator /media/root/usr/home
sudo chroot /media/root
chown -R administrator:user /usr/home/administrator
chmod -R go-rwx /usr/home/administrator 
exit
sudo rm -rf /media/root/home/administrator

Reboot the machine and log into Ubuntu locally to continue.

 1.5 Install Dependencies
We need to install some dependencies for later steps, specifically we need to have ncp, quota, and nfs enabled.

Install sysv-rc to set daemon run levels, nfs-common  for nfs commands  and  tcsh:   
sudo apt-get install -y --force-yes sysv-rc-conf nfs-common tcsh

 1.5.1.1 Install perl-Tk, libcrypt-ssleay-perl  (for graphical netcheck gui):
sudo apt-get install perl-tk  libcrypt-ssleay-perl

 1.5.1.2 Install ncpfs expect  - used for H drive mounter:
sudo apt-get install ncpfs expect 

Install quota
sudo apt-get install quota 

Install C man pages
sudo apt-get install manpages-dev manpages-posix-dev

 1.6 Make a /etc/profile.d directory
Modify /etc/csh.cshrc,  /etc/bash.bashrc   and  /etc/profile  to look at a /etc/profile.d. 

Create /etc/profile.d
This first command should error as the folder already exists, if not it needs to be created:
sudo mkdir /etc/profile.d

cd /etc
sudo cp csh.cshrc csh.cshrc.orig
sudo cp /etc/bash.bashrc /etc/bash.bashrc.orig
sudo cp profile profile.orig

Add the following code to /etc/profile to read scripts in this directory as Ubuntu doesn't natively have this.
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Remember the unset for profile!!!

gksudo gedit /etc/profile

add these linse to /etc/profile
## GU linux lab 
for i in /etc/profile.d/*.sh ; do 
    if [ -r "$i" ]; then 
        . $i 
    fi 
done 
   
unset i 
## 

The text should be added above the unmask command.

To check permissions run:
ls -l /etc/profile

Permissions should look like
-rw-r--r-- 1 root root 621 2008-11-12 10:29 /etc/profile 

add /etc/profile code into /etc/bash.bashrc
gksudo gedit /etc/bash.bashrc

added this to the end of /etc/bash.bashrc
## GU linux lab 
for i in /etc/profile.d/*.sh ; do 
    if [ -r "$i" ]; then 
        . $i 
    fi 
done 

unset i 
## 

Add to the end of the file.

To check permissions run:
ls -l /etc/bash.bashrc 

Permissions should look like
-rw-r--r-- 1 root root 1692 2008-01-17 15:35 /etc/bash.bashrc 

Add these lines to end of /etc/csh.cshrc
gksudo gedit /etc/csh.cshrc

## GU linux lab 
if ( -d /etc/profile.d ) then 
   set nonomatch 
   foreach i ( /etc/profile.d/*.csh ) 
      if ( -r $i ) then 
         source $i 
      endif 
   end 
   unset i nonomatch 
endif 
##

To check permissions run:
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ls -l /etc/csh.cshrc  
 
Permissions should look like
-rw-r--r-- 1 root root 428 2008-11-12 10:15 /etc/csh.cshrc 

 1.7 Filesystem Re-configuration:   /opt
Setup opt as an alternative to /bin.
sudo rmdir /opt
sudo ln -s /usr/local /opt
cd /opt/bin

Link in the important environments.
sudo ln -s /bin/bash         .
sudo ln -s /usr/bin/perl     .
sudo ln -s /bin/tcsh         .

Permissions should look like
ls -l /opt/bin 
total 44 
lrwxrwxrwx 1 root root     9 2008-11-12 10:49 bash -> /bin/bash 
lrwxrwxrwx 1 root root    13 2008-11-12 10:49 perl -> /usr/bin/perl 
lrwxrwxrwx 1 root root     9 2008-11-12 10:49 tcsh -> /bin/tcsh 

Documentation link (for old packages)
cd /opt
sudo ln -s share/doc /usr/doc
sudo ls -Fla /usr/doc/

 1.8 Restrict Umask Permissions
The default Umask permissions are far to permissive for files. This makes them a little more secure as student 
homes do have web pages running in them, and file are visible within the university if incorrectly configured.

Open the profile script:
Sudo nano /etc/profile

replace the existing umask with:
umask 077 
[ "`whoami`" = 'root' ] && umask 022 

This should be before the addition done previously in regard to creating the profile.d directory.

 1.9 Setup SSH
SSH is used in the labs for remote access for fixing problems and staff to test documentation and tutorials 
remotely.

Install SSH Server
sudo apt-get install openssh-server

Configure SSH to only allow admin access for Lab base image
Edit "/etc/ssh/sshd_config" :
gksudo gedit /etc/ssh/sshd_config

and make sure it has the following
PermitRootLogin no
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X11Forwarding yes
PrintMotd yes

Check if this line exists then comment it out
#AllowGroups adm

Make sure the Banner line is commented – if it is not commented Lamboot fails
#Banner /etc/issue.net

Add this line here too...
AllowTcpForwarding no

Modify /etc/ssh_config
gksudo gedit /etc/ssh/ssh_config

Uncomment and modify the following lines
ForwardX11 yes
CheckHostIP no

Restart ssh server (does not destroy existing ssh logins)
sudo /etc/init.d/ssh restart

 1.10 Setup the MOTD File to show GU Policy
Ubuntu runs a script upon bootup called, /etc/init.d/boot.misc.sh, which creates the motd file using motd.tail
Typically limit the use of the sudo su command, however you must be root to run these commands

 1.10.1 Setup MOTD and Issue files
sudo su
cp /etc/motd.tail /etc/motd.tail.orig
echo "Griffith University Lab PC" > /etc/motd.tail
cp -p /etc/issue /etc/issue.orig
echo "Griffith University Lab PC \n \l"  > /etc/issue
cat /etc/motd.tail > /etc/issue.net
exit

To check permissions run:
ls -l /etc/issue.net
ls -l /etc/motd.tail

Permissions should look like
-rw-r--r-- 1 root root 27 2008-12-03 13:58 /etc/issue.net 
-rw-r--r-- 1 root root 27 2008-12-03 13:58 /etc/motd.tail 

 1.10.2 Setup GU Policy

Create a text file containing the GU Policy warning

gksudo gedit /etc/gupolicy

Copy the policy from the GU Website or use this....

Griffith Configured Ubuntu Linux 
,-----------------------------------------------------------------------------. 
|                                                                             | 
|     Use of University Information Technology Resources Code of Practice     | 
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|                                                                             | 
|      Information technology resources are essential for accomplishing       | 
|   Griffith University's mission. Members of the University community are    | 
|   granted shared access to these resources on condition they are used in    | 
|  accordance with the University's Information Technology Code of Practice.  | 
|                                                                             | 
|     This Code of Practice applies irrespective of where the University      | 
|    information technology resources are accessed and used, and includes     | 
|     use at home.  You can expect sanctions if you act irresponsibly and     | 
|           disregard your obligations under the Code of Practice.            | 
|                                                                             | 
|   It is your responsibility to become familiar with the Code of Practice.   | 
|                                                                             | 
|   For enquiries and problems with this machine, please contact, Academic    | 
| Computer Support, via the IT-Assist help line x56464, during office hours.  | 
|                                                                             | 
`-----------------------------------------------------------------------------' 

                                                      EITS, 12 November 2008 

Setup a popup that displays this before the GUI login window
Edit the following file:
gksudo gedit /etc/gdm/Init/Default

and add this line BEFORE the last line  which is “exit 0”
# Displays the GU Policy.  This is placed in this file because we want it to come up 
before the login window 
xmessage -center -file /etc/gupolicy -name 'Griffith Usage Policy' 

Add GU Policy to /etc/motd.tail
sudo su
cat /etc/gupolicy >> /etc/motd.tail 
exit

 1.11 Fix mail of root mail
This will cause machines to send system messages and errors to the administrator. This can be a good thing for 
testing but should be disabled if not needed. 

sudo apt-get install postfix mailx

   Setup : satellite system
   Hostname : griffith.edu.au
   SMTP : smtp.griffith.edu.au

gksudo gedit /etc/aliases
 
unhash root  and copy this string:
root:  root@mage.griffith.edu.au

add changes:
sudo newaliases
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 2 Configuring Network Login and Home Directories

 2.1 Home Directory Plan
In order to complete the login and configuration changes it is important to understand where the homes are kept, 
and how the login trees work.

Students/Staff can Login if :
– a commonuse account

– must have a valid home directory (meaning they are enrolled in ICT or MEE subjects).
– OPTION: Can be configured to require membership to LINUX.groups.Accounts.Na.COMMONUSE
– must have Unix Profile section with these settings

– UID is 1000000 + s number  eg   if s851604, then UID is 10851604
– shell is /bin/bash

– has a home directory on the school linux servers
– homes are kept on Chimera via homes.griffith.edu.au alias
– homes are exported via nfs
– homes are mounted in Ubuntu using autofs
– Ubuntu is configured so the home directory is /home
– /home is linked to /net/homes.griffith.edu.au/export/student/
– /export is linked to /net/homes.griffith.edu.au/export/

– students home directories are kept in /net/homes.griffith.edu.au/export/student/
– must be owned by their snumber

staff home directories are currently kept in /net/homes.griffith.edu.au/export/home/
– so staff need links from the student homes directory to their own home directories

– eg /net/homes/export/student/s111111 -> ../home/s111111/
– must be owned by their snumber
– must have commonuse logins

 2.2 Mount Student/Staff Homes
Automounter is used to mount the student homes and the /source folder.  Source is used to store important files, 
themes, backgrounds, licensing information, and some applications to make it easier to configure the image.

 2.2.1 Install Automounter
sudo apt-get install autofs
gksudo gedit /etc/auto.master

uncomment /net (delete the #):
/net    /etc/auto.net 

Autofs was setup with default run levels
gksudo gedit /etc/auto.misc

Comment out all pre existing entries in the file

Restart the service.
sudo /etc/init.d/autofs restart

 2.2.2 Configure Homes and Source
Create a link to the home directories being exported from Chimera (homes) and source from Mage using 
automounter (/net).
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Remove the contents of home, then remove the home directory safely.
sudo rm /home/.directory
sudo rmdir /home

Set up a symbolic link (Browse to the folder in /net before trying to link. If you find an error just check to see if the 
folders are there and linking correctly.)
sudo ln -s /net/homes.griffith.edu.au/export/  /export
sudo ln -s /net/homes.griffith.edu.au/export/student /home

Create the link to ent for the source folder.
sudo ln -s /net/mage.griffith.edu.au/source/ /source

test this using:
ls -l /source/
ls -l /export/
ls -l /home/

NOTE:
Make sure that you can do a nslookup on your IP and your DNS name
You may need to browse to the /net folder for the above command not to have it show up as a broken link

 2.2.3 Update rc.local from ent mount point
The rc.local file installs the opt/bin scripts such as mount h, netcheck and installs the lab reporting icon and 
scripts. The file automatically updates itself on execution, and updates the mount h, netcheck, and lab reporting 
links. This effectively allows these to be remotely maintained.

Back up the existing rc.local
sudo cp /etc/rc.local /etc/rc.local.orig

Copy the new file across
sudo cp /source/linux_extras/update/rc.local /etc/rc.local
sudo chmod 755 /etc/rc.local

Run rc.local
sudo /etc/rc.local

 2.2.4 Set up attributes for accounts
Attributes are managed via the passwd file stored on Chimera/homes/export. The script should be run on reboot, 
and at 6am. If this file is not updated correctly networked logins will fail.

Copy or create the script in /etc/init.d
sudo cp /source/linux_extras/update/copy_accounts /etc/init.d
sudo chmod 700 /etc/init.d/copy_accounts

Normally this copy_accounts script would be added to /etc/rc.local so that it runs on startup, however our rc.local 
file is already on /source and will be copied down from source and executed each boot. We just set up this file in 
the previous step so lets just quickly populate the passwd file before moving on:
sudo /etc/init.d/copy_accounts
     
add a cron job to run the previous script
sudo  crontab -e -u root
(on Ubuntu 8.10 select 3, it really is the easiest) and add the line
0 6 * * * /etc/init.d/copy_accounts
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 2.3 LDAP Password Authentication
PAM is the Linux/Unix method for authenticating to LDAP and AD domains. There are several files that contain 
key information on how the system should process authentication. The positioning and order of the files is very 
important and you should research before attempting to change any entries. Newer and older versions of PAM do, 
and will have small differences. 

Install the ldap modules
sudo apt-get install ldap-utils libpam-ldap libnss-ldap nscd libpam-doc

You'll be asked to configure some of these modules.  Follow the settings below...

Configuring libnss-ldap
LDAP server Uniform Resource Identifier: ldaps://ldap.griffith.edu.au/
Distinguished name of the search base:  o=COMMONUSE
LDAP version to use: 3
Make local root Database admin:  <left as default – which is Yes>
Does the LDAP database require login?  <left as default – which is No>
Select default options till you get to LDAP account for root: cn=manager,dc=example,dc=net (leave as default)
LDAP root account password: <left as default – which was nothing>
nsswitch.conf not managed automatically     : this is ok

This command will show the file omitting lines starting with a # and then any blanks links:
grep '^[^#]' /etc/ldap.conf 

Point other ldap confs to /etc/ldap.conf:
sudo mv /etc/ldap/ldap.conf  /etc/ldap/ldap.conf.o
sudo ln -s  /etc/ldap.conf  /etc/ldap/ldap.conf 

To check permissions run:
ls -l /etc/ldap/ldap.conf 

Permissions should look like:
lrwxrwxrwx 1 root root 18 2008-12-03 14:29 /etc/ldap/ldap.conf -> /etc/pam_ldap.conf 

This command will show the file omitting lines starting with a # and then any blanks links:
grep -v ^# /etc/ldap.conf  | grep -v ^$ 

 2.3.1 Modify LDAP client configuration files

Modify the following files accordingly...

/etc/pam_ldap.conf - Make a backup copy of the original file, then modify it

sudo cp /etc/ldap.conf /etc/ldap.conf.orig

sudo gedit /etc/ldap.conf

uri ldaps://ldap.griffith.edu.au/ 
ldap_version 3 
base o=COMMONUSE 
scope sub 
pam_filter objectclass=posixAccount 
pam_login_attribute uid 

# Disable compare of CERT key to local copy (changes every year) 
TLS_REQCERT never 
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To check permissions run:
ls -l /etc/pam_ldap.conf 

Permissions should look like
-rw-r--r-- 1 root root 9282 2008-12-03 14:38 /etc/ldap.conf 

Disable unneeded ldap componenents (managed by passwd file and homes from Chimera)
sudo rename 's%/S%/K%' /etc/rc?.d/S*nscd
sudo rename 's%/S%/K%' /etc/rc?.d/S*lbnss-ldap

NOTE: This will likely error if it is run a second time as the filename will have 
already been changed, depending on the version lbnss-ldap may not be installed

Stop the the name server caching service (not wanted as it continually takes resources and crashes).
sudo /etc/init.d/nscd stop 

/etc/pam.d/common-auth - Make a backup copy of the original file, then modify it

sudo cp /etc/pam.d/common-auth /etc/pam.d/common-auth.orig 

gksudo gedit /etc/pam.d/common-auth

Comment out or delete the existing entries
#auth requisite pam_unix.so nullok_secure 
#This is for windows file sharing via samba
#auth optional pam_smbpass.so migrate missingok 

Add these new entries in this order
# must have a valid shell 
auth required      pam_shells.so
auth required   pam_group.so 

#allow local login, ignore broken shadow entry 
auth   sufficient    pam_unix.so try_first_pass 

#allow valid ldap login 
auth   [default=1 success=ignore]   pam_succeed_if.so uid > 1000 quiet
auth    sufficient    pam_ldap.so use_first_pass 

#deny access if none of the above are valid 
auth    required      pam_deny.so

/etc/pam.d/common-account  - Make a backup copy of the original file, then modify it

sudo cp /etc/pam.d/common-account /etc/pam.d/common-account.orig 

gksudo gedit /etc/pam.d/common-account

Comment out or delete the existing entries:
#account [success=2 new_authtok_reqd=done default=ignore] pam_unix.so 
#account [success=1 default=ignore] pam_ldap.so
#account requisite pam_deny.so
#account required pam_permit.

Add these new entries in this order:
# user must have a valid shell 
account   required      pam_shells.so 

#allow local account, ignore broken shadow entry 
account   required   pam_unix.so broken_shadow
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/etc/pam.d/common-password - Make a backup copy of the original file, then modify it

sudo cp /etc/pam.d/common-password /etc/pam.d/common-password.orig 

gksudo gedit /etc/pam.d/common-password

Comment out or delete these entries:
#password [success=2 default=ignore] pam_unix.so obscure sha512 
#password [success=1 user_unknown=ignore default=die] pam_ldap.so use_authtok 
try_first_pass
#password requisite pam_deny.so
#password required pam_permit.so

This file should contain no valid entries as it should never be run. We do not allow users to change their password 
on LDAP from the linux labs.

/etc/pam.d/ common-session  - Make a backup copy of the original file, then modify it

sudo cp /etc/pam.d/common-session /etc/pam.d/common-session.orig 

gksudo gedit /etc/pam.d/common-session

Comment out or delete these entries:
#session [default=1] pam_permit.so
#session requisite pam_deny.so
#session required pam_permit.
#session optional pam_ldap.so 
#session optional pam_ck_connector.so nox11

This line should already exist, if not add it:
session   required   pam_unix.so

Cleanup and checks
sudo rm /etc/pam.d/*~

To check permissions run
ls -l /etc/pam.d/common-* 

Permissions should look like
-rw-r--r-- 1 root root  455 2008-11-19 13:55 /etc/pam.d/common-account 
-rw-r--r-- 1 root root  392 2008-11-19 13:53 /etc/pam.d/common-account.orig 
-rw-r--r-- 1 root root  583 2008-11-19 13:53 /etc/pam.d/common-auth 
-rw-r--r-- 1 root root  484 2008-11-19 13:49 /etc/pam.d/common-auth.orig 
-rw-r--r-- 1 root root 1692 2008-11-19 14:10 /etc/pam.d/common-password 
-rw-r--r-- 1 root root 1571 2008-11-19 13:58 /etc/pam.d/common-password.orig 
-rw-r--r-- 1 root root  480 2008-11-19 14:14 /etc/pam.d/common-session 
-rw-r--r-- 1 root root  372 2008-11-19 14:10 /etc/pam.d/common-session.orig

 2.3.2 Motd comes up twice when sshing
The Pam ssh config file has an entry to display the motd.  Comment this out
 
gksudo gedit /etc/pam.d/sshd

# Print the message of the day upon successful login. 
#session    optional     pam_motd.so # [1] 

File Name:LinuxLab Master Docco - 8.10.odt 
Exported: 13/01/2010 Page 16



 2.4 Startup of the 'Netcheck' GUI
Copy the netcheck gui script (and extras) from ent.
sudo cp /source/linux_extras/misc/optbin/* .
sudo chmod 755 /opt/bin/*

Create a script that runs the netcheck gui
gksudo gedit /etc/X11/Xsession.d/96netcheck_gui

with this in it...

#/etc/X11/Xsession.d/96netcheck_gui
#\!/bin/sh
#kill any existing netcheck session
/opt/bin/netcheck -logout >/dev/null 2>&1 &

#start the Griffith netcheck GUI window for external access
( sleep 5;/opt/bin/netcheck_gui -geometry -15+5 & ) &

Set the permissions so that it is executable
sudo chmod 644 /etc/X11/Xsession.d/96netcheck_gui

To check permissions:
ls -l /etc/X11/Xsession.d/96netcheck_gui 

Permissions should look like:
-rw-r--r-- 1 root root 186 2008-12-03 15:23 /etc/X11/Xsession.d/96netcheck_gui 

Test it by running
/opt/bin/netcheck_gui

Add automatic logout of Netcheck when the Gnome Display Manager (GDM) initializes or resets
Edit this file...
gksudo gedit /etc/gdm/Init/Default

add this line BEFORE the GU Policy line:
/opt/bin/netcheck -logout >/dev/null 2>&1 &

edit this file...
gksudo gedit /etc/gdm/PostSession/Default

add this line BEFORE the last line,  which is “exit 0”
/opt/bin/netcheck -logout >/dev/null 2>&1 &

Permissions for these files looks like
ls -l  /etc/gdm/Init/Default 
-rwxr-xr-x 1 root root 2614 2008-12-03 15:36 /etc/gdm/Init/Default 

ls -l /etc/gdm/PostSession/Default 
-rwxr-xr-x 1 root root 525 2008-12-03 15:36 /etc/gdm/PostSession/Default 

This is handled by rc.local previously added and will not need to be done manually but has been left for better 
understanding of rc.local.

Also in machine startup file "/etc/rc.local" add this line to ensure the PC is logged out of netcheck
Edit this file...
gksudo gedit /etc/rc.local

add this line BEFORE the last line,  which is “exit 0”
/opt/bin/netcheck -logout >/dev/null 2>&1 &
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Permissions should look like
ls -l  /etc/rc.local 
-rwxr-xr-x 1 root root 351 2008-12-03 15:37 /etc/rc.local 

 2.5 H-drive mounter

Now we're going to enable access to user's H drives. Then we'll place a shortcut on their desktop.
This needs  ncpfs and expect,  see Install initial General applications if it isn't

Modify permissions on these files

sudo chmod u+s /usr/bin/ncpmount /usr/bin/ncpumount

Permission should look like
ls -l  /usr/bin/ncpmount /usr/bin/ncpumount 
-rwsr-xr-x 1 root root 129808 2005-12-06 03:06 /usr/bin/ncpmount 
-rwsr-xr-x 1 root root  30336 2005-12-06 03:06 /usr/bin/ncpumount 

The installation and configuration of the the H drive mounter is handled by the rc.local script.   

For Post Login Cleanup, we'll unmount H drive by editing this file 
 
gksudo gedit /etc/gdm/PostSession/Default

and add this line BEFORE the last line (which is  exit 0 )

/opt/bin/mount_h_drive -u >/dev/null 2>&1 &

Permission should look like
ls -l /etc/gdm/PostSession/Default 
-rwxr-xr-x 1 root root 571 2008-12-03 16:37 /etc/gdm/PostSession/Default 

Permission should look like
ls -l /etc/rc.local 
-rwxr-xr-x 1 root root 452 2008-12-03 16:39 /etc/rc.local 

Test the mount H drive script by the following
/opt/bin/mount_h_drive -d -x s851604

Test it via the desktop icon (Requires Reboot)

 2.6 Set the Hostname
The best way to do this is to use the asset tag field in the BIOS however this is not possible for all machines. We 
will cover how to set the name for non standard hardware first, then address how to set the hostname for Dell 
machines.

 2.6.1 Set Hostname for Non-Standard Hardware
From information for this method was taken from http://www.debian-administration.org/articles/447. We need to 
modify  /etc/dhcp3/dhclient-exit-hooks.d/hostname to set the hostname. This method is prone to failure and can 
have problems depending on the DNS system. At Griffith this method will only work if the lab has a fixed IP.

Modify  /etc/dhcp3/dhclient-exit-hooks.d/hostname 

sudo nano /etc/dhcp3/dhclient-exit-hooks.d/hostname

to be the same as:
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#!/bin/sh

# Filename:     /etc/dhcp3/dhclient-exit-hooks.d/hostname
# Purpose:      Used by dhclient-script to set the hostname of the system
#               to match the DNS information for the host as provided by
#               DHCP.
# Depends:      dhcp3-client (should be in the base install)
#               hostname (for hostname, again, should be in the base)
#               bind9-host (for host)
#               coreutils (for cut and echo)
#

if [ "$reason" != BOUND ] && [ "$reason" != RENEW ] \
   && [ "$reason" != REBIND ] && [ "$reason" != REBOOT ]
then
        return
fi

echo dhclient-exit-hooks.d/hostname: Dynamic IP address = $new_ip_address
hostname=$(host $new_ip_address | cut -d ' ' -f 5 | cut -d. -f1)

hostname=$(echo $hostname | sed 's/ pc[0-9]* / /g; s/ pc[0-9]*$//; s/^pc[0-9]* //' )

echo $hostname > /etc/hostname
hostname $hostname

echo dhclient-exit-hooks.d/hostname: Dynamic Hostname = $hostname
# And that _should_ just about do it...

For some odd reason the dhclient doesnt always seem to run to DHCP on startup. To resolve this issue we force a 
DHCP request. Create a script to run on startup:

sudo nano /etc/init.d/setname

With the following text:

#!/bin/sh

# Filename:     /etc/init.d/setname
# Purpose:      Used to force run the dhclient to make sure that the PC
#               name is updated by the system.
# Depends:      dhcp3-client (should be in the base install)
#               hostname (for hostname, again, should be in the base)
#               bind9-host (for host)
#               coreutils (for cut and echo)Bcast:132.234.86.255
#

dhclient

Then set the permissions:

sudo chmod 700 /etc/init.d/setname

 2.6.2 Set Hostname for Standard Hardware
Instead of the more complicated method used previously we can use the BIOS to set the hostname. Make sure 
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the machine has the INS number set in the BIOS.

Create a script that runs the hostname command:

gksudo gedit /sbin/setname

with this in it... 

#!/bin/sh 
# Filename:     /sbin/setname 
# Purpose:      Used to set the hostname of a PC to the contents to the BIOS Asset 
# Tag field with the prefex of PC. Should appear as PC123456. 
# Depends:      dmidecode - should be in the base 
# Permissions:  After copying do the following: sudo chown root:root /sbin/setname 
# && sudo chmod 755 /sbin/setname 

# Get the Asset details from BIOS and create hostname for the machine 
echo pc`dmidecode -s chassis-asset-tag` > /etc/hostname 

exit 0

Set the permissions so that it is executable 
sudo chmod +rx /sbin/setname

Edit the GDM Default to run the script
gksudo gedit /etc/gdm/Init/Default

To contain
# Sets the PC name via Bios 
/sbin/setname

Put the text above the MOTD

Remove the DHCP Naming system to avoid conflicts if you already did it: 
sudo rm /etc/dhcp3/dhclient-exit-hooks.d/hostname
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 3 General Applications

 3.1 Install Open Office 3.0
The current version of Ubuntu still uses the older Open Office 2.4 so we will be updating it to the significantly 
newer Open Office 3.0.

 3.1.1 Uninstall the previous version
Remove old openoffice package: 
sudo apt-get remove openoffice*.*

 3.1.2 Pull OpenOffice.org 3.0 from source
Open a terminal
cd $home
cd Desktop
mkdir OpenOffice
sudo cp -r /source/linux_extras/misc/OOO300_m9_native_packed-1_en-US.9358/* 
OpenOffice
sudo chmod -R 777 OpenOffice
cd Openoffice

Navigate to the debian install folder
cd DEBS

Install all packages:
sudo dpkg -i *.deb

Install desktop integration package:
cd desktop integration
sudo dpkg -i *.deb

(Should not be needed if you have installed Java first)

 3.1.3 Reinstall Spell Checkers and Configure Dictionary
Install spell checkers
sudo apt-get install ispell aspell

Install dictionaries and integration packages:
sudo apt-get install aspell-en dictionaries-common gnome-spell myspell-en-gb 
myspell-en-us 

Configure Dictionary
Copy the Australian dictionary off of source:
sudo cp /source/linux_extras/misc/dict-en-au-2008-11-25.oxt 
/usr/local/openoffice.org3/share/extension/install/dict-en-au.oxt

Open OpenOffice.org Writer and navigate to Tools → Extension Manager
When you open Writer (Applications → Office → OpenOffice.org 3.0 Writer) set the user to GU, untick check for 
updates, and register never.
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Click Add then navigate to /usr/local/openoffice.org3/share/extension/install/ and install dict-en-au.oxt

Restart OpenOffice

 3.1.4 Clean Up
Lastly a little tidying up:
cd $home
cd Desktop
rm -R OpenOffice

 3.2 Install Java 6 JDK
Use synaptic to install the java development kit.

sudo apt-get install sun-java6-*

Accept the licences as they come up until you reach the Java Documentation install.
For sun-java6-doc it will prompt you with the following:
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This package is an installer package, it does not actually contain the
JDK documentation.  You will need to go download one of the archives:

   jdk-6-doc.zip jdk-6-doc-ja.zip

(choose the non-update version if this is the first installation).
Please visit

   http://java.sun.com/javase/downloads/

now and download.  The file should be owned by root.root and be copied
to /tmp.

You have two options, use the file on source by entering the following command or downloading the updated 
version direct from Sun on the link above.

Use:

sudo cp /source/linux_extras/misc/jdk-6u10-docs.zip /tmp/jdk-6-doc.zip
sudo chown root.root jdk-6-doc.zip 

or

Use the link given and click to download the Java SE Documentation. The download will typically use its own 
special download manager, and I recommend downloading the file direct to /tmp

Naviate to /tmp in a new terminal and set the ownership of the file to root as requested by the installer package.
cd /tmp
sudo mv jdk-6u10-docs.zip jdk-6-doc.zip
sudo chown root.root jdk-6-doc.zip 

continue with java install in the other terminal by hitting enter.

You should see a message if this has worked

File Name:LinuxLab Master Docco - 8.10.odt 
Exported: 13/01/2010 Page 23



/tmp/jdk-6-doc.zip has been unpacked and installed. 
You can now delete it, if you wish. 

At the time of writing there was a problem with the java-fonts package:

Setting up sun-java6-fonts (6-07-3ubuntu2) ... 
Updating fontconfig cache for /usr/share/fonts/truetype/ttf-lucida 
No CIDSupplement specified for Batang-Bold, defaulting to 0. 
No CIDSupplement specified for UKaiCN, defaulting to 0. 
No CIDSupplement specified for Batang-Regular, defaulting to 0. 
No CIDSupplement specified for UMingCN, defaulting to 0. 
No CIDSupplement specified for KochiGothic-Regular-JaH, defaulting to 0. 
No CIDSupplement specified for Dotum-Bold, defaulting to 0. 
No CIDSupplement specified for KochiMincho-Regular, defaulting to 0. 
No CIDSupplement specified for KochiGothic-Regular, defaulting to 0. 
No CIDSupplement specified for KochiMincho-Regular-JaH, defaulting to 0. 
No CIDSupplement specified for Dotum-Regular, defaulting to 0. 
dpkg: error processing sun-java6-fonts (--configure): 
 subprocess post-installation script killed by signal (Interrupt) 
Setting up sun-java6-javadb (6-07-3ubuntu2) ... 
Setting up sun-java6-source (6-07-3ubuntu2) ... 
Errors were encountered while processing: 
 sun-java6-fonts 
E: Sub-process /usr/bin/dpkg returned an error code (1) 

The error has been reported and this should be fixed for future versions. It will not be fixed for this version but 
should not prevent normal use.

 3.3 Install Language packs
System → Administration → Language Support
Agree to install the full language support

Tick Arabic, Chinese, Japanese, Korean

 3.4 Install VLC player
Video Lan Codec, a universal media player

sudo apt-get install vlc

 3.5 Install NTFS USB Support
Enable support for NTFS formatted USB.

sudo apt-get install ntfs-config
   
Press  Alt + F2, to get the ‘Run Application’ dialog box.
type in gksudo ntfs-config and click Run
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Tick ‘Enable write support for external device’

 3.6 Install kernel extras
NOTE:
Each one of these will install a large number of dependancies.     

Install kernel build tools
sudo apt-get install build-essential

Install kernel development tools
sudo apt-get install linux-kernel-devel

Install full source and config for current kernel
sudo apt-get install linux-source 

 3.7 Install Medibuntu Applications
Install medibuntu repository
sudo wget http://www.medibuntu.org/sources.list.d/hardy.list -O 
/etc/apt/sources.list.d/medibuntu.list

Update medibuntu GPG Key
sudo apt-get update && sudo apt-get install medibuntu-keyring && sudo apt-get update

You do want to install the medibuntu keyring, and you do want to install without verification

 3.7.1 Install Acrobat 
sudo apt-get install acroread acroread-plugins mozilla-acroread

 3.7.2 Install Ubuntu studio meta packages
sudo apt-get install ubuntustudio-video ubuntustudio-graphics

NOTE:
This will install a large number of dependancies.

 3.7.3 Install multimedia codec's

sudo apt-get install gstreamer0.10-ffmpeg gstreamer0.10-plugins-base gstreamer0.10-
plugins-good gstreamer0.10-plugins-bad gstreamer0.10-plugins-bad-multiverse 
gstreamer0.10-plugins-ugly gstreamer0.10-plugins-ugly-multiverse
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 3.7.4 Install tetex-extra
sudo apt-get install tetex-extra

 3.7.5 Install emacs
sudo apt-get install emacs
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 4 Customising Gnome

 4.1 Install Griffith Themes
Navigate to System → Administration → Logon Window
Click the Local tab and set Style to Themed and Theme to Selected Only
Click on the Remote tab set Style to Same as Local
Click the Security tab then check the boxes for Allow remote system administrator login, and Allow local system 
administrator login.
Click the Users tab and uncheck Include all users from /etc/passwd

 4.1.1 Install Griffith login theme
Install the Griffith custom login theme:
Navigate to System → Administration → Logon Window
Navigate to the Local tab
Click the add button, then browse to 
/source/linux_extras/theme/ and open Griffith_Theme.tar.gz
Select Griffith Login from the list
Click the Closed button

 4.1.2 Install Griffith 
backgrounds
To complete the theming process we have a Griffith 
background image for the system to use. This image has to 
be set up in such a way that the system ignores the clients 
default background and uses the system one that we 
specify. The easiest way to do this is to force a mandatory 
background specified by the local system settings.

NOTE:
Default is set to use 3x4 backround image. The file will 
need to be modified for individual labs that have 16x10 
images. The original files were modified to reflect the 
filenames of the new backgrounds and were placed on 
source to make the install process easier, and to allow 
them to be changed as required via rc.local

Remove the existing backgrounds and install the new ones:
sudo rm /usr/share/backgrounds/*
sudo cp /source/linux_extras/theme/backgrounds/* /usr/share/backgrounds/
sudo chmod 755 /usr/share/backgrounds/*

Replace configuration files with ones matching the new files:
sudo cp /source/linux_extras/theme/ubuntu-wallpapers.xml /usr/share/gnome-
background-properties/ubuntu-wallpapers.xml
sudo cp /source/linux_extras/theme/ubuntu-wallpapers.xml 
/usr/share/gconf/defaults/16_ubuntu-wallpapers

Configure the system to force the backround settings:
sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set 
/desktop/gnome/background/picture_filename "/usr/share/backgrounds/filename.jpg"

The filename above will be Desktop10x16.jpg or Desktop3x4.jpg
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sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set 
/desktop/gnome/background/secondary_color "#000000"

sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set 
/desktop/gnome/background/primary_color "#000000"

sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set 
/desktop/gnome/background/picture_options "scaled"

NOTE:
For more information see http://docs.sun.com/app/docs/doc/806-6878/6jfpqt2t7?a=view or obtain a copy of the 
sun solaris gnome desktop administrators guide
For a graphical view of the gnome desktop configuration settings use gconf-editor, it is recommended to make the 
changes using the command line.

 4.2 Configure Interface options
Set the interface theme to clearlooks
sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set 
/desktop/gnome/interface/gtk_theme "Clearlooks"

Set default archive to be .zip for windows compatability
sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set /apps/file-
roller/dialogs/batch-add/default_extension ".zip"

 4.3 Firefox 
branding – back to Ubuntu
sudo mv /etc/alternatives/firefox-homepage /etc/alternatives/firefox-homepage.orig
sudo mv /etc/alternatives/firefox-homepage-locales /etc/alternatives/firefox-
homepage-locales.orig 

sudo ln -s /usr/share/ubuntu-artwork/home/firefox-index.html 
/etc/alternatives/firefox-homepage 
sudo ln -s /usr/share/ubuntu-artwork/home/locales-ubuntu /etc/alternatives/firefox-
homepage-locales 

 4.4 Restrict access to Network 
settings
Remove  Network manager from tray 
open System > Preferences > Sessions and untick the Network 
Manager entry

also go into Current Session and Remove nm-applet
session options -> save current session

 4.5 Turn off update services
Right click on the icon then go Preferences->Updates-
>Automatic Updates   
   untick Check for updates
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Click close

Right click on icon, Show notifications

Hide Update Notifier
System -> Preferences -> Sessions->Startup Programs 
   uncheck Update Notifier
Firefox
Run firefox and clear the data by going:
Tools - Clear Private Data - check everything.

 4.6 Edit Menus
We have too many menu's so we want to remove the 
following:
Education
Games
Other
System Tools

Navigate to the application shortcuts
cd /usr/share/applications 

Check to make sure to required entries are picked up: 
grep "Categories\s*=\s*.*Game\;.*" 
*.desktop 

Remove previous entries from the menu (by setting read 
rights to null) 
sudo chmod -r `grep -l 
"Categories\s*=\s*.*Game\;.*" *.desktop` 

Check to make sure to required entries are picked up: 
grep "Categories\s*=\s*.*Other\;.*" *.desktop 

Remove previous entries from the menu (by setting read rights to null) 
sudo chmod -r `grep -l "Categories\s*=\s*.*Other\;.*" *.desktop` 

Check to make sure to required entries are picked up: 
grep "Categories\s*=\s*.*Education\;.*" *.desktop 

Remove previous entries from the menu (by setting read rights to null) 
sudo chmod -r `grep -l "Categories\s*=\s*.*Education\;.*" *.desktop` 

NOTE: 
If the check picks up and entry you do not want removed/or in error you have two choices. Manually give it access 
again by sudo chmod 755 <filename> or edit the .desktop file to make it part of a different category before 
removing the entries.

 4.7 Printer Setup
Install Dependancies:
sudo apt-get install libglitz-glx1

Install Novell iPrint (the 8.04 package will still work under 8.10):
cd /source/linux_extras/misc 
sudo dpkg -i 8.04_novell-iprint*

Because its a converted RPM package there are a few links missing:
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sudo ln -s /opt/novell/iprint/plugin/npnipp.so /usr/lib/firefox-
3.0.5/plugins/npnipp.so 
sudo ln -s /opt/novell/iprint/plugin/npnipp.so /usr/lib/firefox/plugins/npnipp.so 

 4.7.1 For Nathan Printing
Open firefox and go to http://honey-bear.griffith.edu.au/ipp/ and click on:

StudentPrint-NA-IPRINT-HOLD-BW 
StudentPrint-NA-IPRINT-HOLD-COL

Accept to install and printing is configured.

 4.7.2 For Gold Coast Printing
Open firefox and go to http://drop-bear.griffith.edu.au/ipp/ and click on:

StudentPrint-GC-IPRINT-HOLD-BW 
StudentPrint-GC-IPRINT-HOLD-COL

Accept to install and printing is configured.
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 5 Clean Up

 5.1 Locking down Gnome
Here are some useful GConf keys to set as mandatory: 

Run gksudo gconf-editor in a terminal then browse to the trees to set the values:

For each of these right click and ‘set as mandatory’ on the entry value you are unchecking or checking.

• apps → panel → global: check locked_down, and disable_lock_screen
• desktop → gnome → lockdown: check disable_user_switching and disable_lock_screen
• (Optional) apps → metacity → global_keybindings: Go here to disable/set keybindings (such as removing 

the default ALT+F2 = run dialogue so students cannot arbitrarily run any program on the system) 
• apps → gnome_settings_daemon → screensaver: uncheck start_screensaver 
• apps → gnome-screensaver → user_switch_enabled uncheck and `set as mandatory`
• apps → panel → global → disabled_applets: Add 'OAFIID:GNOME_FastUserSwitchApplet'
• apps → gnome-power-manager → general: uncheck  ‘can_hibernate’ and ‘can_suspend’ 

NOTE: If you are not familiar with GConf, please read up on it via the links below to understand how it works and 
how to set mandatory keys, as this is important if you want to lock down settings for all users. To fix something set 
to mandatory that should not have been done run gksudo gedit /etc/gconf/gconf.xml.mandatory/
%gconf-tree.xml and edit the file OR you can go to the mandatory tab in gconf-editor by going File → New 
Mandatory Window.

 5.2 Clean out any extra sessions
Open ~/.metacity/sessions and check how many sessions it has, if it has more than 1, remove them all and create 
default0.ms with the entry 0 inside it.

Open System → Preferences → Sessions and remove all entries.

Log out, then in again.

Open  System → Preferences → Sessions and make sure the following are the only checked boxes:

Print Queue Applet, Volume Manager, PulseAudio Session management, Tracker, Power Manager

 5.3 Clean up Firefox
Turn off auto updates
Edit → Preferences → Advanced → Udpate
untick Autocheck for firefox, addins, search engines

Turn off remember passwords
Edit → Preferences → Security, untick Remember passwords for sites
clear any exisitng remembered passwords

Clear temp locations
tools → clear private data  ,  delete everything

Edit → preferences → privacy tick Always ask to clear my private data and untick ask me before clearing.

Set homepage to www.griffith.edu.au
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 6 Application Installs
This is list of installation instructions for applications that can be used in ICT and MEE labs. Please verify which 
versions of applications such as Comsol, Matlab, and Eclipse are require before installing all listed applications.

 6.1 Common Applications
The applications appear to be common to all labs, if a program is identified to be specific to a particular school it 
should be moved into the school specific area.

 6.1.1 Install generic programming tools
sudo apt-get install bluefish quanta planner gcc libc6-dev python-dev python-
setuptools python-profiler  anjuta

 6.1.2 Install libtool, automake and autoconf 
sudo apt-get install libtool automake autoconf autoconf-archive autoconf-doc

 6.1.3 Install subversion and kdesvn
sudo apt-get install subversion kdesvn

 6.1.4 Install symlinks
sudo apt-get install symlinks

 6.1.5 Install openmotif
sudo apt-get install libmotif-dev motif-clients

 6.1.6 Install eclipse
Download Eclipse RCP package from the www.eclipse.org

OR transfer 3.4.3 from source:
sudo cp /source/linux_extras/mee-ict_installers/eclipse-rcp*.* 
/usr/home/administrator/Desktop/

You will find eclipse-rcp-ganymede-SR1-linux-gtk.tar.gz on your desktop.

Installing Eclipse manually
https://help.ubuntu.com/community/EclipseWebTools
we want to install Eclipse into /opt  according to User spec in above website using the RCP/PDE package and 
download the CDT

extract eclipse
cd /usr/home/administrator/Desktop/
tar -xvzf eclipse-rcp-*

install it into /opt
sudo mv eclipse /opt/eclipse
cd /opt
sudo chown -R root:root /opt/eclipse && sudo chmod +x `sudo find eclipse -type d`

make it executable...
sudo touch /usr/bin/eclipse
sudo chmod 755 /usr/bin/eclipse
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sudo nano /usr/bin/eclipse

to contain...
#!/bin/sh
#export MOZILLA_FIVE_HOME="/usr/lib/mozilla/"
export ECLIPSE_HOME="/opt/eclipse"

$ECLIPSE_HOME/eclipse $*

permissions look like:
ls -l /usr/bin/eclipse 
-rwxr-xr-x 1 root root 118 2007-11-23 13:30 /usr/bin/eclipse 

create a menu icon
sudo nano /usr/share/applications/eclipse.desktop

to contain...
[Desktop Entry] 
Encoding=UTF-8 
Name=Eclipse 
Comment=Develop applications in a variety of different programming languages 
Exec=eclipse 
Icon=/opt/eclipse/icon.xpm 
Terminal=false 
Type=Application 
Categories=GNOME;Application;Development; 
StartupNotify=true 

permissions look like:
ls -l /usr/share/applications/eclipse.desktop 
-rw-r--r-- 1 root root 254 2007-11-21 16:56 eclipse.desktop 

Verify permissions for eclipse:
sudo chmod -R +r /opt/eclipse 
sudo chmod +x /opt/eclipse/eclipse

You now have a working eclipse. But run this command first to initialise the set up. 
/opt/eclipse/eclipse -clean

see more info about -clean  in  http://www.eclipsezone.com/eclipse/forums/t61566.html

Then from here on you can run from the menu item applications/programming/eclipse 

Install the CDT (C development tools)

Run Eclipse as root...
sudo eclipse

The software updates are done through netcheck and can be over 100mb. (if only I realised that first)

Help->Software Updates->Available Software
Select version update site (in this case  Ganymede)
In the sub menu select C and C++ Development, and Java Development
click Next, accept the license, and click Finish to install.
Restart Eclipse
close Eclipse

Cleanup
cd /usr/home/administrator/Desktop/

File Name:LinuxLab Master Docco - 8.10.odt 
Exported: 13/01/2010 Page 33

http://www.eclipsezone.com/eclipse/forums/t61566.html


rm -R eclipse*

 6.1.7 GNUstep Software

Install GCC
GCC and GDB are installed by default and are central files to Ubuntu. It is HIGHLY recommended not to upgrade 
them past what is available in the repositories unless there is a serious problem.

Install m4
sudo apt-get install m4 m4-doc

Install GNUSTEP
Requires these packages
gnustep-base
gnustep-gui
gnustep-back
gnustep-make

You can also in stall gnustep-startup which wil install all of the above. Find the latest version here:
http://ftpmain.gnustep.org/pub/gnustep/core/

gorm
projectcentre
libart-2.0-dev

Requirements – you must have installed GCC (plus GMP and MPFR) first before installing GNUstep

Install GNUstep, Project Centre, Gorm, and Renaissance
Install some libraries to keep GNUstep happy:
sudo apt-get install libjpeg62 libjpeg62-dbg libjpeg62-dev libtiff4-dev libpng12-dev 
libxml++2.6-dev libffi4-dbg libffi4-dev libcrypto++-dev libssl-dev libart-2.0-dev 
libgcc1-dbg libobjc1 libobjc2 libobjc2-dbg

We will be installing these applications from versions cached on /source

Do some cleanup first in case there was a previous install, not needed on a clean build
sudo mv /usr/GNUstep /usr/GNUstep.old
sudo rm -rf /usr/gnustep_build

Create the build folder and copy and extract the files.
cd /usr/ 
sudo mkdir gnustep_build; cd gnustep_build 
sudo cp /source/unix/GNUstep/*.tar.gz /usr/gnustep_build
for i in /usr/gnustep_build/*.tar.gz; do sudo tar -xvzf $i ; done 

Build and install the applications.
sudo su
(cd gnustep-startup-*; ./InstallGNUstep; ) 
. /usr/GNUstep/System/Library/Makefiles/GNUstep.sh 
(cd ProjectCenter-*; make install; ) 
(cd gorm-*; make install; ) 
(cd Renaissance-*; make install; ) 

Cleanup and Configure for user
cd; rm -rf /usr/gnustep_build
rm -rf /usr/GNUstep.old

echo > /etc/profile.d/gnustep.sh \ 'source 
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/usr/GNUstep/System/Library/Makefiles/GNUstep.sh'
echo > /etc/profile.d/gnustep.csh \ 'source 
/usr/GNUstep/System/Library/Makefiles/GNUstep.csh'

 6.1.8 Install QT
C++ cross platform gui

sudo apt-get install qt4-dev-tools qt4-designer  qt4-doc qt4-qtconfig

test QT by running it:

designer

 6.1.9 Install Ogre
sudo apt-get install ogre-doc  ogre-tools  libogre-dev

 6.2 ICT Applications
These applications are only used in ICT lab environments and do not need to be installed into the MEE Lab 
environments.

 6.2.1 Install gobjc, libobjc, libaio, freeglut
 Gobjc is  ubuntu's package for Gcc-objc - the objective c compiler

sudo apt-get install gobjc  gcc-4.1-doc libobjc1 libaio1 freeglut3 libglut3-dev

 6.2.2 Install ddd
sudo apt-get install ddd ddd-doc

 6.3 MEE Applications
These applications are only used in MEE lab environments and do not need to be installed into the ICT lab 
environments.

 6.3.1 GNU C compiler for the Motorola 68HC11/12
Requires gcc, newlib, gdb, and binutils (already installed)

sudo apt-get install gcc-m68hc1x  newlib-m68hc1x  gdb-m68hc1x binutils-m68hc1x

Allocate permissions so that students can read and write to serial and USB

sudo chmod +rw /dev/tty*

 6.3.2 Install OpenMPI 
sudo apt-get install openmpi-bin openmpi-common libopenmpi-dev libopenmpi1 

 6.3.3 Install tk, xpvm  pvm
sudo apt-get install tk8.4 xpvm pvm pvm-dev
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 6.3.4 Install GNUPLOT
sudo apt-get install gnuplot  gnuplot-doc

test it by running 
gnuplot
plot sin(x) (should show sin curve)
quit

 6.3.5 Install Minicom
sudo apt-get install minicom

initialise minicom 

sudo minicom -s

Serial Port setup  
Serial Device :  /dev/ttyUSB0 
Bps/Par/Bits:     9600 8N1
then save as default

Setup minicom permissions on serial port for graphical user only

We only want the person in front of the PC to be able to access the serial port/USB ports, ttyS0 and ttyUSB0, 
which DR plugs HW into. 

By default, these ports are owned by root and anyone in the dialout group can use them.
s -l /dev/ttyS0   shows this

Students can run minicom can’t they are LDAP users, and are not made members of the “dialout” group.

Considering we’ve used pam_group.so to assign LDAP users to the “audio” group, we just add “dialout” to that list 
of groups.

edit /etc/security/group.conf 

gksudo gedit /etc/security/group.conf

add  dialout   like follows:

login;*;*;Al0000-2400;audio, dialout
kdm;*;*;Al0000-2400;audio, dialout
gdm;*;*;Al0000-2400;audio, dialout

This is the part that assigns all users logging in to the users, audio and dialout groups.

 6.3.6 Install setserial
sudo apt-get install setserial

 6.3.7 Install Driver Compiles
Checked through the following...
http://dinomite.net/archives/setting-up-ubuntu-for-building-kernel-modules

Setting Up Ubuntu for Building Kernel Modules
Get the kernel source for the running version:
Note $KERNEL_VERSION is a system call that uses the current kernel set up by the first command run.
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Download the Source
export KERNEL_VERSION=`uname -r|cut -d '-' -f 1`
sudo aptitude install linux-source-$KERNEL_VERSION

Configure Kernel Source
cd /usr/src/
sudo tar jxf linux-source-$KERNEL_VERSION.tar.bz2
sudo ln -s linux-source-$KERNEL_VERSION linux
sudo ln -s /usr/src/linux /lib/modules/`uname -r`/build

First, in order to get things to build against the kernel you have to alter a single file to match the kernel you’re 
running. Run uname -r and note everything following the first three decimal-separated numbers:

uname -r
2.6.24-23-generic 

Just use a text editor and edit /usr/src/linux/Makefile, changing the EXTRAVERSION variable to match yours from 
above:

sudo nano /usr/src/linux/Makefile

VERSION = 2 
PATCHLEVEL = 6 
SUBLEVEL = 24 
#EXTRAVERSION = .6 
EXTRAVERSION = -23-generic 
NAME = Err Metey! A Heury Beelge-a Ret! 

Next, you need to get the .config for the running kernel and setup the kernel source:

sudo cp /boot/config-`uname -r` /usr/src/linux/.config

 6.3.8 GCC-hc12 Cross-compiler
Used by David Rowlands
   
already done as part of dependencies

 6.3.9 Add commands  insmod,rmmod,lsmod  to "sudo"
Used by David Rowlands
 
sudo  visudo

and add these lines at the bottom
Navigate to where you want to insert, press I to insert
Paste in:
# added these commands - Used by David Rowlands
ALL ALL=/sbin/lsmod,/sbin/insmod,/sbin/rmmod,/bin/setserial,/bin/mknod 

Press escape to exit text edit mode
Save the file
:w

Quit
:q

 6.3.10 Install Dinotrace and Verilog
Used by David Rowlands and Brett Wildermoth
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Verilog is available from http://www.icarus.com/eda/verilog/
v8.5.1 is installed from repository, latest version is v8.7.

sudo apt-get install verilog

Dinotrace is available from http://www.veripool.com/dinotrace/
According to website, we need to install....

sudo apt-get install lesstif2-dev 

Copy the installer (v9.3) from source
sudo cp /source/linux_extras/mee-ict_installers/dinotrace*.tg*z 
/usr/home/administrator/Desktop/

Navigate to the desktop and extract the file
cd /usr/home/administrator/Desktop/

tar xvf dinotrace*.tg*z

Configure and install:
cd dinotrace*
./configure
make

Test the application
./dinotrace traces/ascii.tra

Install the Application
sudo make install

dinotrace

Cleanup
cd /usr/home/administrator/Desktop/
sudo rm -R dinotrace*

 6.3.11 MatLab R2008b
Prepare the install directory and licence
sudo mkdir /extra/matlabR2008b 
cd /extra/matlabR2008b/

Copy the Matlab license into /opt/matlabR2008b/licenses and rename it to network.lic
Make sure the license file has license.griffith.edu.au  instead of just license in the first line.
sudo mkdir licenses 
sudo cp /source/linux_extras/misc/Matlab-r2008b-PermIP.dat 
/extra/matlabR2008b/licenses/network.lic
sudo chmod 555 /extra/matlabR2008b/licenses/network.lic

Install Process
Install from the DVD by the following...

sudo /media/cdrom/install & 

If you have problems with trying to install and get an error message like...
/bin/sh: bad interpreter: Permission denied

then
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sudo -s 
umount /media/cdrom
mount -t iso9660  /dev/cdrom /media/cdrom0
cd /extra/matlabR2008b
/media/cdrom/install & 

Select Install manually without using the Internet and agree to the terms

Change installation directory to /extra/matlabR2008b
The installer will ask for the File Installation Key: XXXXXXXXXXXXXXXXXXXX
Remove License Manager from the install list
Check the box, then click Ok to create symbolic links in /usr/local/bin

NOTE: The text will be greyed out if the box is not checked. If this is not done you will have to manually create 
symbolic links for students so they can run Matlab.

The installer will ask for the licence file location: /extra/matlabR2008b/licenses/network.lic
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Click OK to begin the installation

Test as user

matlab

Configure a menu shortcut as Matlab does not create one.

Copy the icon file:
sudo cp /source/linux_extras/mee-ict_installers/matlab/matlab.ico 
/extra/matlabR2008b/matlab.ico
sudo chmod +r  /extra/matlabR2008b/matlab.ico

Copy the shortcut:
sudo cp /source/linux_extras/mee-ict_installers/matlab/matlab.desktop 
/usr/share/applications/matlab.desktop
sudo chmod +r matlab.desktop

 6.3.12 Comsol 3.2
Requested by Jun Wei Lu

Insert CD 1 and copy   install.pdf  from it onto the desktop.  You can't be accessing CD1 when you install because 
then it will cause problems when you need to eject it for CD 2.

sudo mkdir /extra/comsol32 
sudo sh /media/cdrom/clsetup

Click Make new installation
Licence format: Port number @hostname

License details:
   port: 1234, host: licence.griffith.edu.au
   Name: Student Company: Griffith University

Platform
   Only Linux should be checked
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Installation
Full Installation
Destination folder:  /extra/comsol32
MATLAB interface:   MATLAB installation folder: /extra/matlab

Click Install

Create a symbolic link to comsol
sudo ln -s /extra/comsol32/bin/comsol /opt/bin/comsol 

test it
comsol

Configure a menu shortcut as Comsol does not create one.

Copy the icon file:
sudo cp /source/linux_extras/mee-ict_installers/comsol/comsol.ico 
/extra/comsol132/comsol.ico
sudo chmod +r  /extra/comsol132/comsol.ico

Copy the shortcut:
sudo cp /source/linux_extras/mee-ict_installers/comsol/comsol.desktop 
/usr/share/applications/comsol.desktop
sudo chmod +r comsol.desktop

 6.3.13 Comsol 3.5a Install Process
In a terminal type:
sudo su 
mkdir /extra/comsol35a
cd /media/cdrom0
./setup /media/cdrom0 /extra/tmp

It should then run the graphical installer, follow the screens as below:
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License details:
   Port: 1234
   Host: licence.griffith.edu.au
   Name: Student 
   Company: Griffith University

Currently all labs use 32bit Linux installations.

There is no need to install the License Manager as we are not running a licence server from the local machine.
Comsol should be installed to /extra/comsol135a and the Matlab interface should be enabled with the Matlab 
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folder as /extra/matlabR2008b.

To run the application easily we need to manually create some symbolic links to the executable, so create a 
symbolic link to Comsol:
sudo ln -s /extra/comsol35a/bin/comsol /opt/bin/comsol

test it
comsol

Configure a menu shortcut as Comsol does not create one.

Copy the icon file:
sudo cp /source/linux_extras/mee-ict_installers/comsol/comsol.ico 
/extra/comsol135a/comsol.ico
sudo chmod +r  /extra/comsol/comsol.ico

Copy the shortcut:
sudo cp /source/linux_extras/mee-ict_installers/comsol/comsol.desktop 
/usr/share/applications/comsol.desktop
sudo chmod +r comsol.desktop
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 7 Deploying to Lab Hardware

 7.1 Preferred Imaging Method
Prepare the machine with the Windows image ready for deployment then add in the Ubuntu image for the 
school (MEE/ICT). The image is then customised for the hardware type and a final lab image is created.

 7.1.1 Prepare the Drive for Imaging
Boot the PC via a Ubuntu Live CD

Press Alt-F2 and type:

gksudo gparted

Manually reduce the size of the windows partition if necessary. The Linux image requires a 
minimum of 25GB and a Maximum of 35GB. Extra is used on MEE installations to hold Matlab and 
Comsol, if you are not deploying an MEE image, do not create extra and remove the entry from 
fstab (detailed later).

Create and extended partition on the disk that is a minimum of 30GB and a Maximum of 40GB. 
The extended partition will be sized down after all the partitions are created, logical partitions 
require slightly more size on disk for the same sized primary partition.

Inside this partition create the following partitions with the appropriate attributes.

Partition Type MB Location FS
root Logical 15360 Beginning ext3
tmp Logical 5120 Beginning ext3
swap Logical 5120 Beginning swap
extra Logical 15360 Beginning ext3

After imaging resize the extended to the size of the partitions.

 7.1.2 Deploy the Image
Deploy the Windows image to the disk. Create a session using the Non -ir version of the image and set the 
session to image individual linux partitions one at a time.

 Deploy partition 1 (sda5) to the root partition (15360MB)
 Deploy partition 2 (sda6) to the tmp partition (5120MB)
 Deploy partition 3 (sda7) to the swap partition (5120MB)
 Deploy partition 4 (sda8) to the extra partition (15360MB) if it is being used

 7.1.3 Repairing Grub after deployment
After imaging the linux side will not boot because GRUB has been damaged, and Windows does not know 
GRUB exists.

Boot from a Ubuntu Live CD
Fire up Terminal (Alt + F2 and type gnome-terminal)

sudo su
fdisk -l
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The linux partitions will be in this order:
SDA1 will be Windows C:
SDA2 will be missing or Windows D:
SDA4 will be the Extended partition for Linux
SDA5 will be root or /
SDA6 will be /tmp
SDA7 will be swap
SDA8 will be /extra

 1 
Make mount point and mount the Linux System partition so we can edit grub
mkdir /media/root
mount /dev/sda5 /media/root

 7.1.3.1 Update grub

Update Grub to prevent student changes by pasting the following line in over the commented out line:
sudo nano /boot/grub/menu.lst

password --md5 $SOME HASH

grub

locate the root partition
find /boot/grub/stage1

(returns hd0,4)

set the root partition as found

root (hd0,4)

For dual boot configuration install grub into sda4 (the linux file system partition) – this leaves the MBR 
untouched

setup (hd0,4)  

For single boot configuration install grub to sda (the MBR)

setup (hd0)

In doing this you update grub so that it can find the filesystem again.

quit

Copy grub to windows partition (for a dual boot senario)

mkdir /media/win
mount /dev/sda1 /media/win
dd if=/dev/sda5 of=/media/win/linux.bin bs=512 count=1

Make sure the sda# references the correct number from fdisk.
Check and see if the linux.bin file is referenced in the boot.ini file.

nano /media/win/boot.ini

#check for the following line:
c:\linux.bin="Ubuntu"
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reboot... should bring up windows boot loader.

 7.1.4 Configure  Fstab
If you did not deploy the /extra partition you will need to clean up fstab, if you did then move on to installing 
the hardware specific drivers. Either way, boot into the linux image and edit fstab

Fire up Terminal (Alt + F2 and type gnome-terminal)

gksudo gedit /media/root/etc/fstab 

Remove the section referencing if you have not included /extra
Replace the UID values with the /dev/sda# on the line above.
Save the file and close

 7.2 Alternative Imaging Method
This is an alternative imaging method discovered as a result of problems with Ghost handling 256bit inode 
sizes in Ghost 11.5.1. This is not recommended as it cause significant deployment challenges but has been 
included as a reference that may assist in event of other unforeseen circumstances.

 7.2.1 Deploying the Image
Deploy the Linux image to the drive as a -ia image and boot with a Linux Live CD. Move the Linux partitions 
to the end of the disk by extending the extended partition to the end of the disk and draging each partition to 
the end of the disk. Reduce the Extended partition to the size of the partitions and create a FAT32 partition 
that uses the now empty space at the front of the drive.

Apply the changes and go get a coffee, it takes a fair while, roughly 2 hours.

Deploy the Windows image as a PARTITION into the empty partition at the front of the drive. If you deploy it 
as a disk you will have to start again.

 7.2.2 Repairing Grub and Windows MBR
The current situation of the image is that Grub is the Master Bootloader and the Window Bootloader does not 
exist. To resolve this issue we have a Linux application that can write the Windows Bootloader back in that 
can be found in the Debian repositories called ms-sys.

It is importaint to note that the order of the disks has now changed, the Windows partition is now SDA2.

sudo fdisk -l 

Device Boot      Start         End      Blocks   Id  System 
/dev/sda1           14230       19452    41953747+   f  W95 Ext'd (LBA) 
/dev/sda2               1       14229   114294411    c  W95 FAT32 (LBA) 
/dev/sda5           14231       16188    15727635   83  Linux 
/dev/sda6           16189       16841     5245191   83  Linux 
/dev/sda7           16842       17494     5245191   82  Linux swap / Solaris 
/dev/sda8           17495       19452    15727603+  83  Linux

 7.2.2.1 Install MS-SYS
It is recommended to do this stage from a Live USB as opposed to a live CD as you can install the 
application needed on a permanent basis.

The file has been cached on mage and can be found at /source/linux_extras/misc/ms-sys_2.1.0-1_i386.deb. 

To gain access to source follow the following commands:
sudo apt-get install autofs
gksudo gedit /etc/auto.master
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uncomment /net (delete the #):
/net    /etc/auto.net 

Autofs was setup with default run levels
gksudo gedit /etc/auto.misc

Comment out all pre existing entries in the file

Restart the service.
sudo /etc/init.d/autofs restart

Connect to mage:
sudo ln -s /net/mage.griffith.edu.au/source/ /source/

Now we can install ms-sys:

sudo dpkg -i /source/linux_extras/misc/ms-sys_2.1.0-1_i386.deb

Now we can fix the MBR.

 7.2.2.2 Fixing the Windows MBR, and Reconfiguring Grub
Mount the local root partition: 
sudo mkdir /media/root 
sudo mount /dev/sda5 /media/root 

Edit the GRUB menu: 
sudo nano /media/root/boot/grub/menu.lst 

Find the line: 
### BEGIN AUTOMAGIC KERNELS LIST 

Add this ABOVE that line: 

title Windows XP 
root (hd0,1) 
makeactive 
savedefault 
chainloader +1 

Install GRUB to the MBR 

sudo grub 
find /boot/grub/stage1 

will return: (hd0,4) 

Also set the boot track for the disk (will be replaced later) 
root (hd0,4) 
setup (hd0) 

quit 

Reboot and verify all partitions load successfully, then reboot to live environment and run the ms-sys app on 
the root of the drive (sda) 

sudo ms-sys -m /dev/sda 

Clean up the GRUB menu: 
sudo mount /dev/sda5 /media/root 
sudo nano /media/root/boot/grub/menu.lst 
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Comment out or delete: 
title Windows XP 
root (hd0,1) 
makeactive 
savedefault 
chainloader +1 

Set Grub back to using the Partition instead of the Root.
sudo grub 

Set the root partition in grub 
root (hd0,4) 

Setup the boot track for the linux partition 
setup (hd0,4) 

quit

Because of the changes we have made to the boot we have to update the linux.bin file sitting on the 
Windows partition.
mkdir /media/win 
mount /dev/sda2 /media/win 
dd if=/dev/sda5 of=/media/win/linux.bin bs=512 count=1 

 7.2.2.3 Troubleshooting
In using this method we found out that we would experience some incidents of Grub failing to load through 
correctly on boot. Here are the steps required to get Grub working again.

Boot off of a Linux Live CD and run the following in a terminal:

sudo su 

Rebuild Grub
grub 
root (hd0,4) 
setup (hd0,4) 
quit 

Replace the linux.bin file
mkdir /media/win 
mount /dev/sda2 /media/win 
dd if=/dev/sda5 of=/media/win/linux.bin bs=512 count=1 

 7.2.3 Configure  Fstab
If you did not deploy the /extra partition you will need to clean up fstab, if you did then move on to installing 
the hardware specific drivers. Either way, boot into the linux image and edit fstab

Fire up Terminal (Alt + F2 and type gnome-terminal)

gksudo gedit /media/root/etc/fstab 

Remove the section referencing if you have not included /extra
Replace the UID values with the /dev/sda# on the line above.
Save the file and close
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 7.3 Hardware Customisation

 7.3.1 Install Drivers
While most hardware will work on the default drivers without any problems some hardware types have 
manufacturer drivers avalible for linux and these should be installed. 

To install these navigate to System → Administration → Hardware Drivers

Install the drivers recommended.

 7.3.2 For Widescreen Machines
Boot to into Ubuntu off the local disk.

 7.3.2.1 Install Griffith wide-screen login theme
Install the Griffith custom login theme:
Navigate to System → Administration → Logon Window
Navigate to the Local tab
Click the add button, then browse to /source/linux_extras/theme/ and open Griffith-Login-Widescreen.tar.gz
Select Griffith Login from the list
Click the Closed button

 7.3.2.2 Install Griffith wide-screen background
To set the background enter:
sudo gconftool-2 --direct --config-source 
xml:readwrite:/etc/gconf/gconf.xml.mandatory --type string --set 
/desktop/gnome/background/picture_filename 
"/usr/share/backgrounds/Desktop10x16.jpg"

 7.4 Troubleshooting

 7.4.1 Optiplex 960 Partitioning Errors
If you are trying to resize the partitions on a Optiplex 960 and having problems check if the partition type is 
gpt. Hit alt-f2  and type gnome-terminal then enter:

sudo fdisk -l

The top line will be a warning if the disk is a gpt, if it is run:

sudo parted
mklabel msdos

This is wipe the disk and set it so it can be managed via gparted.

 7.4.2 Grub Errors
if you have having problems with grub this will either fix them, or give you errors that should allow you to 
work out where the fault is:

Fire up Terminal (Alt + F2 and type gnome-terminal)

sudo su
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mkdir /mnt/root
mount /dev/sda5 /mnt/root
chroot /mnt/root

update-grub

This may bring up a window to select what menu.lst file to use, its recommended to keep the existing one 
unless there has been a kernel update. If there has been you will need to check the base image 
documentation to configure grub.

 7.5 Lab Specific Changes

 7.5.1 N44 1.05 Changes
Because the 1.05 lab has dual DNS names, one the standard and one pokemon, a change needs to be 
made to /etc/dhcp3/dhclient-exit-hooks.d/hostname to avoid error messages from a variety of applications 
that expect the PC name to have no spaces. Without this change the PC names in this lab will show as 
PC123456 Pokemon.

#!/bin/sh 

# Filename:     /etc/dhcp3/dhclient-exit-hooks.d/hostname 
# Purpose:      Used by dhclient-script to set the hostname of the system 
#               to match the DNS information for the host as provided by 
#               DHCP. 
# Depends:      dhcp3-client (should be in the base install) 
#               hostname (for hostname, again, should be in the base) 
#               bind9-host (for host) 
#               coreutils (for cut and echo)Bcast:132.234.86.255 
# 

if [ "$reason" != BOUND ] && [ "$reason" != RENEW ] \ 
   && [ "$reason" != REBIND ] && [ "$reason" != REBOOT ] 
then 
        return 
fi 

echo dhclient-exit-hooks.d/hostname: Dynamic IP address = $new_ip_address 
hostname=$(host $new_ip_address | cut -d ' ' -f 5 | cut -d. -f1) 
hostname=$(echo $hostname | 
              sed 's/ pc[0-9]* //g; s/ pc[0-9]*$//; s/^pc[0-9]* //' ) 
echo $hostname > /etc/hostname 

hostname $hostname 

echo dhclient-exit-hooks.d/hostname: Dynamic Hostname = $hostname 
# And that _should_ just about do it... 

The changed line has been highlighted in bold.

 7.5.2 N44 -1.16 Changes
THESE CHANGES HAVE BEEN INCLUDED FOR HISTORICAL PURPOSES.
-1.16 has a dual monitor configuration with the secondary monitor to the left of the primary. Because these 
machines run ATI graphics cards they require some additional tweaking to display correctly.
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Install and enable the right drivers. Start a Terminal and run the following commands:

sudo apt-get update 
sudo apt-get install linux-restricted-modules-generic restricted-manager 
sudo apt-get install xorg-driver-fglrx 
sudo depmod -a 

These instructions came from here: http://wiki.cchtml.com/index.php/Ubuntu_Hardy_Installation_Guide 

If in doubt or confused use 
sudo aticonfig --help 

To set up dual head: 
sudo aticonfig --initial=dual-head --screen-layout=right --dtop=horizontal 
--overlay-on=1 

(This command means I have 2 monitors and the secondary screen is right of my primary. The overlay-on 
command allows the user to drag windows from one screen to the other.) 

Because we have 2 monitors and the secondary screen is left of the primary we need to do something a little 
different. 

To set up dual head for secondary left of primary: 
sudo aticonfig --initial=dual-head --screen-layout=left 
--dtop=horizontal,reverse --overlay-on=1 

(This command means I have 2 monitors and the secondary screen is left of my primary) 

One thing to note was that both monitors were the same size and resolution. 
What are the size and resolutions of the monitors your using? 

If you have monitors of different resolutions then you may have to try these commands as well: 

(For your primary monitor, indicated by the number 0 after the = sign, try this command substituting in your 
resolutions) 

sudo aticonfig --resolution=0,1600x1200,1280x1024,1024x768 

(This command for the second monitor. Notice the 1 after the = sign meaning your second monitor. Don't 
forget to change the resolutions as needed) 

sudo aticonfig --resolution=1,1600x1200,1280x1024,1024x768 

Don't forget try typing at the command line "sudo aticonfig --help" if you get 
stuck or follow the link I inserted earlier to the ubuntu wiki about ATI cards.
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 8 Troubleshooting

 8.1 Source, Export, and Homes Failing
This is a problem with the AutoFS application. This will show up as the copy scripts failing, the students 
logins failing, and the source, home, and export folder missing, or not showing the files they should contain.

You can verify this by attempting to browse to /source, /export, or /home. If the folders have no contents (ls 
-laH) then there is a problem with the connection. Verify that the server is up by typing ping 
mage.griffith.edu.au

This is usually a problem with the machine not receiving a DNS correctly and can be resolved by making the 
machine have a static (fixed) IP. If that doesn't work, delete and re-netreg the PC.

 8.2 Problems when logging in 
How to solve problems with Student's who can't login to the linux labs

The cause is usually one of three things:

- their student disk quota is full

- their linux desktop config files are dodgy

- password is not sync'd properly

Problem:  Can't login to the GUI
 
Fix process:

You can switch between console mode (CTRL+ALT+F1) and GUI (CTRL+ALT+F7) mode.

Switch to console mode, and try logging in

→ if they can't login to console mode
            fix: sync password, and login to GUI again

      →  if they can login
            fix: check/fix disk quota, and login to GUI again

          →  if still can't login to GUI
                  fix: dodgy desktop config files, and login to GUI again ( the files starting 

with .g* in the student home directory.

                   → if still can't login to GUI
                            fix:  get help from someone else:P

 
Fix:  Rsync Rassword

Get them to change their netcheck password, wait 15 mins and reboot their PC.   

If they can't reset their netcheck password because they can't login to windows or commonuse labs, get 
them to check their enrolment and call x55555

 

File Name:LinuxLab Master Docco - 8.10.odt 
Exported: 13/01/2010 Page 52



Fix:  Check/Fix Disk Quota
 

check disk quota, by running  "quota"
if blocks is larger than quota

       delete mozilla cache files in  ~/.mozilla/firefox/*.default/Cache/

       run "quota" again
              if still over quota
                     get them to delete some other files

Fix:  Dodgy Desktop Config Files

move all their desktop config files into a folder by:

        mkdir  ~/olddesktopstuff

        mv  ~/.g*   ~/olddesktopstuff/

 
Fix:  Get Help

speak to either Matthew Lye, Nicolas Rossow, or Anthony Thyssen

Eventually it will probably go to RCS because it may be a server/accounts issue.

 8.3 GNUstep doesn't work for Students

Students should be accessing /etc/profile when they login and should have GNUstep environment variables 
listed when doing a  “printenv”. If for some reason they are not GNUstep will work perfectly for the 
administrator login but fail for student logins.

 9 Scripts 
It has been pointed out that contents of all the scripts should be available for examination to better 
understand what is going on in the image. All scripts for the labs can be retrieved from mage.griffith.edu.au 
for examination as required. Here are the steps for retrieving all the scripts:

Browse ftp://mage.griffith.edu.au:21 and download the scripts from the following directories, or install 
automounter and copy them via terminal:

The files you are looking for are located in the following directories:
/source/source/linux_extras/update/copy_accounts
/source/source/linux_extras/update/rc.local
/source/source/linux_extras/misc/optbin/*
/source/source/linux_extras/misc/hostname

sudo apt-get install autofs
gksudo gedit /etc/auto.master

uncomment /net (delete the #):
/net    /etc/auto.net 

Autofs was setup with default run levels
gksudo gedit /etc/auto.misc

Comment out all pre existing entries in the file
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Restart the service.
sudo /etc/init.d/autofs restart

Connect to mage:
sudo ln -s /net/mage.griffith.edu.au/source/ /source/

Browse to the desktop and create a folder for the scripts:
cd ~/Desktop/
mkdir image_scripts
Copy the scripts:
cp /source/source/linux_extras/update/copy_accounts ~/Desktop/image_scripts/
cp /source/source/linux_extras/update/rc.local ~/Desktop/image_scripts/
cp /source/source/linux_extras/misc/optbin/* ~/Desktop/image_scripts/
cp /source/source/linux_extras/misc/hostname ~/Desktop/image_scripts/

 10 Appendix A - Potential additions

 10.1 Install and Configure Additional Display 
Managers
SPECIAL NOTE:
When dealing with an image with multiple display managers many changes need to be run on all display 
managers. XFCE and KDM are supplied as an option for legacy support, not as a requirement. To have full 
functionality many changes will need to be done in all three display managers. This document specifies 
explicitly how to make the changes in GDM, the default for Ubuntu and not any of the others.

Install optional display managers XFCE and KDM:
sudo apt-get update
sudo apt-get install ubuntu-restricted-extras kubuntu-desktop xubuntu-desktop

NOTE:
You'll be asked to configuring KDM
   Select the desired default display manager: gdm
You'll be asked to accept the licence for Java

Reboot PC

Make sure gnome is set as the default:
You may find the KDM or XFCE boot and shutdown screens have taken over, there is a bug that means they 
take a higher priority. If they have run this command:
sudo update-alternatives --config usplash-artwork.so

It will show a menu:

There are 3 alternatives which provide `usplash-artwork.so'. 

  Selection    Alternative 
----------------------------------------------- 
          1    /usr/lib/usplash/usplash-theme-ubuntu.so 
*+        2    /usr/lib/usplash/usplash-theme-kubuntu.so 
          3    /usr/lib/usplash/usplash-theme-xubuntu.so 

Press enter to keep the default[*], or type selection number:

Select the version for ubuntu then run this command to rebuilt the package:
sudo dpkg-reconfigure linux-image-$(uname -r)

After this the login screen will still show either Xubuntu of Kubuntu and the default session will be KDE or 
XFCE depending on the order of install. To fix this follow the commands:
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Click the General tab and set default session to Gnome
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